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Experiment HM-5: Kinesiology and Electromyogram (EMG) Activity in Targeted 
Muscles

Lab written in conjunction with: 
Kelly Helm PhD, Director Exercise Science, Department of Kinesiology; 
Amanda Ulin & Kelsey Draper, Seniors, Biology & Exercise Science; Valparaiso University, 

Valparaiso, IN
Jennifer Rosene PT, MS; Plymouth, NH

Background

One of the biggest deterrents for those wanting to start exercising is that they simply don't know where 
to begin. The idea of targeted muscle training is to group muscles into working “units” and target their 
training specifically for the group of muscles. Exercises are then tailored to work the individual muscles 
in the group.  By measuring electromyogram (EMG) activity or each of the muscles in the group, it is 
easy to tell if the muscle you want to be using is the one that is actually doing the work. 

The easiest way to understand muscle movements is by the motion you must make to target and work 
that particular muscle or muscle group. The best way to simplify all of the movement patterns is to call 
them "push" or "pull" movements. "Push" movements describe any motion you must make to push the 
weight away from your body and "pull" movements are those motions you must make to pull the weight 
into your body. Certain muscle groups complement one another in that they require the same "push" or 
"pull" movement type to target the muscle.

An example of a "push" movement exercise is the bench press  This exercise is used to work the muscles 
in your chest but also incorporates your shoulders and triceps which are all "push" movement muscles. 
An example of a "pull" movement exercise is the bent-over row.  This exercise is used to work the 
muscles in your back but also incorporates your biceps which are all "pull" movement muscles.

To make this easier to understand:  "Push" movement body parts include: the muscles of the chest, 
shoulders, triceps, quadriceps (vastus muscles and rectus femoris), and the muscles in the calves. "Pull" 
movement body parts include: the muscle of the back, biceps, hamstrings (semimembranosus, 
semitendinosus and biceps femoris), and the abdominal muscles.  It is important to note that there are 
exceptions and variations to these movements, especially in working the leg muscles. Leg muscles are 
large and are often worked using compound movements that incorporate the gluteus muscles, the 
quadriceps and the hamstrings. 

This lab will allow the grouping of muscles, specifically those in the hip area, and target movements to 
exercise those individual muscles. Recording EMG activity while doing these exercises will give 
immediate feedback as to whether the muscle being targeted by a specific exercise is the one that is 
actually being used.

Any group of three muscles can be used for this lab and appropriate exercises for the targeted muscles 
can be found online and by speaking to the campus athletic trainer or physical therapist.  The muscles 
that are easy to focus on would be the quadriceps or the hamstrings as an addition to this lab. 
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Major 
Muscle 
Group 

Location
Functional 

Role 
Exercise to 
Strengthen

Sample Stretch Notes

Abdominal Stomach
Sitting up, 
postural 
alignment 

Crunches, 
leg raises, 
twisting 
crunches 

You typically don't stretch 
your abs. For most people, 
the abs are not strong 
enough, so you need to 
work on strengthening them 
rather than stretching them 

The rectus abdominus is 
the muscle that is visible. 
The transversus 
abdominus muscle, which 
stabilizes your back, is 
underneath.

Biceps
Front of 
upper arm

Lifting, 
pulling 

Bicep Curls 

Sit on floor. Place hands 
behind you with fingers 
pointing away from your 
body. Walk your hips away 
from your hands.

Anytime you move your 
hand toward your 
shoulder, you are using 
your biceps. 

Deltoids
Top of 
shoulder

Overhead 
lifting

Pushups, 
bench press, 
side & rear 
arm raises 

"Scratch your Back" - Put 
both hands over your head. 
Bend one elbow and place 
hand on back. With other 
hand, push elbow to stretch 
triceps, deltoids, lats

The deltoids are composed 
of three parts, anterior, 
posterior & medial. 
Anytime you "flap" your 
arms, your deltoids are 
working. 

Erector Spinae Low back 
Postural 
alignment 

Back 
extensions 

"Cat Stretch" - Kneel on all 
fours, round back like a cat. 
Sit on chair with feet 
shoulder distance apart. 
Bend over and place 
shoulders between your 
knees 

The erector spinae is 
sometimes called the "low 
back" muscle, although it 
runs up your entire back. 

Gastrocnemius 
& Soleus

Back of 
lower leg 

Push off for 
walking, 
standing on 
tiptoes 

Standing calf 
raises, seated 
calf raises

Lunges with a straight back 
leg for gastrocnemius. 
Lunges with bent knees for 
soleus. 

The gastrocnemius gives 
your legs a rounded shape. 
The soleus is underneath 
the gastrocnemius. 

Gluteus Buttocks

Climbing 
stairs, 
walking, 
standing up

Squat, leg 
press 

Sit on chair, cross other leg 
over thigh of bent leg, lean 
forwards. 

Made up of several 
muscles. The largest 
muscle in the body is the 
gluteus maximus.

Hamstrings Thigh - back Walking

Squats, 
lunges, leg 
extensions, 
leg curls 

While standing, place heel 
of leg to be stretched on a 
chair. Keep your leg as 
straight as possible, your 
hips square and your back 
flat. Bend at the waist 
toward your leg.

The hamstrings are made 
up of three muscles. Don't 
squat below 90 degrees, 
otherwise you could 
damage your knees. 

Human Muscle – Kinesiology and Targeted Muscles HM-5-2



iW
or

x S
am

ple
 La

b

Latissimus 
Dorsi & 

Rhomboids 

Back - Lats 
are the large 
triangular 
muscle in 
the midback. 
Rhomboids 
are between 
the shoulder 
blades 

Postural 
alignment, 
pulling open a 
door 

Lats - pull 
ups, chin 
ups, lat pull 
downs 
Rhomboids - 
chinups & 
bent arm 
rows

"Scratch your Back" - Put 
both hands over your head. 
Bend one elbow and place 
hand on back. With other 
hand, 
To stretch rhomboids, "hug 
yourself" Cross your hands 
in front of you, place both 
hands on your shoulder 
blades. 

Developed lats give your 
back a "V" shape, making 
your waist appear smaller. 

Obliques Side of body 
Rotation and 
side flexion of 
body 

Twisting 
crunches, 
rotary torso

Lie on your back with your 
arms extended out ("T" 
shape) Bend both knees. 
Rotate your hips and put 
your bent legs on the floor 
on your side.

Strong internal and 
external oblique muscles 
ward off back pain.

Pectoralis
Front of 
upper chest

Push up from 
lying position, 
push open a 
door

push-up, 
pull-up, 
bench press

While standing, hold both 
arms out at shoulder height, 
palms forward. Pull arms 
back. 

The pectoralis muscles 
pull the shoulder and arm 
forward. 

Quadriceps Thigh - front 

Climbing 
stairs, 
walking, 
standing up

Squats, 
lunges, leg 
presses 

While lying on side, grasp 
ankle, push hips forward

The quads are made up of 
four muscles. 

Trapezius

Large 
muscle in 
upper and 
mid-back.

Moves head 
sideways, 

upright 
rows, 
shoulder 
shrugs 

Upper trap stretch. Sit in a 
chair; put your left hand 
behind you. Tilt your head 
so your right ear moves 
toward your right shoulder. 
Repeat on the other side. 

Your upper trapezius 
connects your head to your 
shoulders. When you feel 
"knots in your neck", it's 
your trapezius. 

Triceps
Back of 
upper arm

Pushing

Pushups, 
tricep 
extensions, 
dips 

"Scratch your Back" - Put 
both hands over your head. 
Bend one elbow and place 
hand on back. With other 
hand, push elbow to stretch 
triceps, deltoids, lats

Anytime you extend your 
lower arm, you are using 
your triceps
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Experiment HM-5: Kinesiology and Electromyogram (EMG) Activity in Targeted 
Muscles

Lab written in conjunction with: 
Kelly Helm PhD, Director Exercise Science, Department of Kinesiology; 
Amanda Ulin & Kelsey Draper, Seniors, Biology & Exercise Science; Valparaiso University, 

Valparaiso, IN
Jennifer Rosene PT, MS; Plymouth, NH

Equipment Required

PC or Mac Computer

USB cable

IX-BIO4 or IX-BIO8 data recorder 

Seven electrode lead wires

Disposable electrodes

Alcohol swabs

Metronome

Chair 

4 inch aerobic step

IX-BIO Setup

Use the USB cable to connect the computer to the USB port on the IX-BIO. 

Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 
not available, click on the Windows Start menu, move the cursor to All Programs and then to the 
listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window will 
appear as the program opens.

2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, IXBIO.iwxgrp. Select this group and click 
Open.

4. Pull down the Settings menu again. Select the KinesiologyTargetedMuscles settings file from 
Human Muscle.

5. After a short time, LabScribe will appear on the computer screen as configured by the 
KinesiologyTargetedMuscles settings.
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6. For your information, the settings used to configure the LabScribe software and the IXTA unit 
for this experiment are programmed on the Preferences Dialog window which can be viewed by 
selecting Preferences from the Edit menu on the LabScribe Main window.

7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any of 
the following documents:

• Appendix

• Background

• Labs

• Setup (opens automatically)

Subject Attire:

It is important that the subject wear loose comfortable clothing that allows for the attachment of seven 
(7) electrodes to the hip area. Bending, stretching, standing and lying down are all part of the exercise 
protocols that will be used.  Comfortable, loose running shorts or pants are a good choice. 

EMG Cable Setup

1. Locate seven electrode lead wires and attach them to the color coded connectors on the IX-BIO 
(Figure HM-5-S1).

Figure HM-5-S1: The IX-BIO4 with seven EMG lead wires and electrodes connected.
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Figure HM-5-S2: Position of electrodes used to record EMG from muscles in the hip during various 
exercises.

2. Locate the muscles of the hip region over which the recording electrodes will be placed. Muscles 
can be located by flexing,extending, abducting and adducting the leg and noting the areas of the 
hip where the muscles are tense:

Human Muscle – Kinesiology and Targeted Muscles HM-5-6
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• One pair of recording electrodes will be placed over the Tensor Fasciae Latae muscle. 
The first electrode in this pair will be placed about 4 centimeters below the lateral edge of 
the anterior superior iliac spine. The second electrode in this pair will be placed about 2 
centimeters below the other electrode along the midline of the Tensor muscle.

• The second pair of electrodes will be placed over the Gluteus medius muscle below the 
lateral edge of the iliac crest. The first electrode in this pair will be placed about 2 
centimeters below the crest, at the midline of the leg. The second electrode in this pair 
will be placed about 2 centimeters just to the posterior of the first electrode.  Make sure to 
stay on the Gluteus medius.

• The third pair of electrodes will be placed on the Gluteus maximus muscle.  These two 
electrodes can be placed high on the Gluteus maximus, but below the iliac crest, so as not 
to interfere with clothing.  Make sure the electrodes are at least 2-3 centimeters apart, on 
the 'meaty' porton of the upper Gluteus maximus.  Avoid getting these electrodes on the 
medius.

• A seventh electrode, used as the ground, will be placed on the lower abdomen of 
whichever leg has been chosen for the electrode placement.

3. Use an alcohol swab to clean and scrub the areas where the electrodes will be placed (Figure 
HM-5-S2). Let the areas dry before attaching the electrodes.

4. Remove the plastic disk from a disposable electrode and apply it to one of the scrubbed areas. 
Attach an electrode to each of the other areas.

5. Snap the recording lead wires onto the electrodes, so that:

• the red “+1” lead is attached to the 1st electrode on the Tensor fasciae latae by the anterior 
superior iliac spine.

• the black “-1” lead is attached to the 2nd electrode on the Tensor fasciae latae.

• the white “+2” lead is attached to the 1st electrode lateral edge of the Gluteus medius.

• the brown “-2” lead is attached to the 2nd electrode on the lateral/posterior area of the 
Gluteus medius.

• the blue “+3” lead is attached to the 1st electrode on the upper posterior area of the 
Gluteus maximus.

• the yellow “-3” lead is attached to the 2nd electrode about 2-3 cm from the first electrode 
on the 'meaty' portion of the upper Gluteus maximus.

• the green “C” lead (the ground) is attached to the electrode in the center of the box 
formed by the positions of the four recording electrodes.
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Experiment HM-5: Kinesiology and Electromyogram (EMG) Activity in Targeted 
Muscles

Lab written in conjunction with: 
Kelly Helm PhD, Director Exercise Science, Department of Kinesiology; 
Amanda Ulin & Kelsey Draper, Seniors, Biology & Exercise Science; Valparaiso University, 

Valparaiso, IN
Jennifer Rosene PT, MS; Plymouth, NH

NOTE – Open the Appendix for diagrams and directions for all the muscle exercises to be 
used in this lab.

Exercise 1: Targeted Muscles and EMG Activity in the Hip

Aim: To study the EMG activity in specific targeted muscles that work in conjunction to strengthen the 
hip and gluteus muscles.

Procedure

1. Instruct the subject that he or she will be doing the following during this exercise:

• Before the recording begins, the subject should read and understand all the exercises that need 
to be performed during this lab activity. 

• Make sure the subject has no known hip, lower back or knee injuries, issues or problems.

• All exercises will be performed in the same manner.

• Each exercise will be held for 4 seconds;

• There will be a 4 second rest period between repetitions (reps);

• Each exercise will be performed for 5 reps.

• The metronome should be set appropriately for doing the exercises.

A. Bilateral Bridge

2. Before starting the recording, type the name of the first exercise, <Bilateral Bridge>, in the Mark 
box to the right of the Mark button. Instruct the subject to get into position to perform this 
exercise.

3. Click the Record button in the upper right corner of the LabScribe Main window. Either click on 
the Mark button or press the Enter key on the keyboard to label the recording. 

4. As soon as the record button is clicked, have the subject complete 5 reps of the “Bilateral 
Bridge” exercise.

• Make sure to engage core muscles and follow the directions as shown in the Appendix.

5. After the 4 second rest period after the 5th rep, click Stop to halt the recording.

Human Muscle – Kinesiology and Targeted Muscles HM-5-8
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6. Click AutoScale on all channels to show the complete EMG activity.

7. The recording should look similar to what is shown in Figure HM-5-L1.

Figure HM-5-L1: Muscle EMG activity as the subject is performing the bilateral bridge.Channels show 
the Tensor fasciae latae, Gluteus medius and Gluteus maximus muscles.

B. Standing Leg Abduction

1. Repeat steps 2 – 5 above for Standing Leg Abduction.

2. Click AutoScale on all channels to amplify signals. The recording should be similar to Figure 
HM-5-L2.

3. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 
in which to save the file, like your lab group folder. Designate the file type as *.iwxdata. Click on 
the Save button to save the data file. 

C. Forward Lunge

1. Repeat steps 2 – 5 above for Forward Lunge.

2. Click AutoScale on all channels to amplify signals. 

3. Click on the Save button to save the data file. 
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Figure HM-5-L2: Recordings from the three muscles while doing the Standing Leg Abduction.

D. Clam
1. Repeat steps 2 – 5 above for the Clam.

2. Click AutoScale on all channels to amplify signals. The recording should be similar to Figure 
HM-5-L3.

3. Click on the Save button to save the data file. 

Figure HM-5-L3: Recording during the Clam exercise.
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E. Squat
1. Repeat steps 2 – 5 above for the Clam.

2. Click AutoScale on all channels to amplify signals. 

3. Click on the Save button to save the data file.

F. Side-Step
1. Repeat steps 2 – 5 above for the Side-Step.

2. Click AutoScale on all channels to amplify signals. 

3. Click on the Save button to save the data file.

G. Standing Hip Extension – Knee Extended
1. Repeat steps from above for the Standing Hip Extension.

2. Click AutoScale on all channels to amplify signals. The recording should be similar to Figure 
HM-5-L4.

3. Click on the Save button to save the data file.

Figure HM-5-L4: Standing Hip Extension – Knee Extended
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H. Standing Hip Extension – Knee Flexed

1. Repeat steps from above for the Standing Hip Extension.

2. Click AutoScale on all channels to amplify signals. 

3. Click on the Save button to save the data file.

I. Forward Step Up

1. Repeat steps from above for the Forward Step-Up.

2. Click AutoScale on all channels to amplify signals. The recording should be similar to Figure 
HM-5-L5.

3. Click on the Save button to save the data file.

Figure HM-5-L5: Forward Step Up

J. Standing Hip Hike

1. Repeat steps from above for the Standing Hip Hike.

2. Click AutoScale on all channels to amplify signals. 

3. Click on the Save button to save the data file.

Human Muscle – Kinesiology and Targeted Muscles HM-5-12

file:///Users/stephenhauptman/Desktop/IX%20USB%20Stuff/IXBIO%20Experiments/IPLMv4_html/Human%20Muscle/AntagonisticMuscles-LS2.htm#Rdt39006
file:///Users/stephenhauptman/Desktop/IX%20USB%20Stuff/IXBIO%20Experiments/IPLMv4_html/Human%20Muscle/AntagonisticMuscles-LS2.htm#Rdt39006


iW
or

x S
am

ple
 La

b

Data Analysis

1. Scroll through the recording and find the first complete section of data recorded while the subject 
was doing the Bilateral Bridge.

2. Use the Display Time icons to adjust the Display Time of the Main window so all 5 reps appear 
on the Main window. The five reps can also be selected by:

• Placing the cursors on either side of the 5 repetitions; and

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the segment 
with the three cycles to the width of the Main window.

3. Click on the Analysis window icon in the LabScribe toolbar (Figure HM-5-L6) or select Analysis 
from the Windows menu to transfer the data displayed in the Main window to the Analysis 
window (Figure HM-5-L7).

Figure HM-5-L6: The LabScribe toolbar.

4. Look at the Function Table that is above the uppermost channel displayed in the Analysis 
window. The mathematical functions, Abs. Int. and  T2-T1 should appear in this table. The 
values for Abs. Int. and T2-T1 for each muscle are seen in the table across the top margin of each 
channel.

5. Click and drag the cursors to be on either side of one EMG contraction on the Tensor fasciae 
latae muscle.  Place them to they are exactly 4 seconds apart.

• Use the right and left arrow keys to get the cursors exactly 4 seconds apart, after you have 
moved them to the location surrounding the EMG activity.

• Click Tools

• Choose “Lock Cursor Separation” to lock the cursors to a 4 second interval.

6. Once the cursors are placed and locked for measuring the first EMG burst, the values for the 
parameters can be recorded in the on-line notebook of LabScribe by typing the names and values 
directly into the Journal, or on a data table.
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7. The functions in the channel pull-down menus of the Analysis window can also be used to enter 
the names and values of the parameters to the Journal. To use these functions:

• Place the cursors at the locations used to measure the absolute integrals as above.

• Transfer the name of the mathematical function used to determine the absolute integrals to 
the Journal using the Add Title to Journal function in the Anterior Channel pull-down menu.

• Transfer the values for the absolute integrals to the Journal using the Add All Data to Journal 
function in the Anterior Channel pull-down menu.

Figure HM-5-L7: EMG activity from the Tensor fasciae latae, Gluteus medius and Gluteus maximus 
muscles. Cursors are placed exactly 4 seconds apart to measure the EMG activity taking place 
simultaneously in the three muscles.  The muscle with the highest activity is the muscle firing the 
strongest.

8. The values for Abs. Int. and T2-T1 on the channels are the relative amounts of the EMG activity 
and the 4 second duration during which the EMG burst occurred.

9. Record the values from each muscle group during the first EMG burst in the Journal, or on a data 
table

10. Use the mouse to move the cursors to onset and offset of the next EMG burst and measure and 
record the values for Abs. Int. and T2-T1 from the muscles. 

Human Muscle – Kinesiology and Targeted Muscles HM-5-14
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11. Measure the Abs.Int and T2-T1 for the EMG bursts from the three muscles for the remaining 
three repetitions.

12. Average the values for the Abs. Int. taken from the muscles during the exercise. Enter the 
averages for each muscle during the first exercise on Table HM-5-L1.

13. Select Save from the File menu. 

Note – You may need to “unlock” cursor separation to continue the lab and “relock” when 
performing data analysis.

Exercise 2:  EMG Activity in other Targeted Muscle Sites

Aim: To study the EMG activity in other targeted muscle groups.

Procedure
1. Use the same experimental setup used in Exercise 1.

2. Choose a different group of muscles to use:

• Quadriceps: use the Vastus lateralis, Vastus medialis and Rectus femoris

• Hamstrings: use the Semimembranosus, Semitendinosus and Biceps femoris

• Shoulder: use the Deltoid, Biceps brachii and Triceps brachii

Data Analysis
1. Use the same procedures used in Exercise 1 to measure and record the Abs. Int. and T2-T1 from 

each muscle when using a different targeted muscle groups.

Questions
1. What muscles are activated during each of the exercises?

2. Can the muscles be “trained” to work the target muscle without involving the other muscles of 
the selected group?

• If so, how would you go about making sure the targeted muscle is the one that is firing 
during a certain exercise?

3. If other muscles besides the targeted muscle are involved during an activity, how can you tell 
which muscle is doing the majority of the activity?
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Table HM-5-L1: Relative EMG Activity in the Hip Muscles  during a variety of exercises.

Averages from Tensor 
fasciae latae

Averages from Gluteus 
medius

Averages from Gluteus 
maximus

Action Abs.Int.
T2-T1 
(sec)

Abs.Int.
T2-T1 (sec)

Abs.Int. T2-T1 
(sec)

Bilateral Bridge

Standing Leg 
Abduction

Forward Lunge

Clam

Squat

Side Step Up

Leg Extension – 
Knee Extended

Leg Extension – 
Knee Flexed

Forward Step Up

Standing Hip Hike

Human Muscle – Kinesiology and Targeted Muscles HM-5-16
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Experiment HM-5: Kinesiology and Electromyogram (EMG) Activity in Targeted 
Muscles

Lab written in conjunction with: 
Kelly Helm PhD, Director Exercise Science, Department of Kinesiology; 
Amanda Ulin & Kelsey Draper, Seniors, Biology & Exercise Science; Valparaiso University, 

Valparaiso, IN
Jennifer Rosene PT, MS; Plymouth, NH

EXERCISES FOR TARGETED MUSCLES

Note:  These exrecises should be performed only by individuals in good health, with no lower back, 
knee, or hip injuries.

Exercises should be performed using correct body positioning as shown and explained.

Core muscle engagement is critical when doing all of these exercises.

1. Bilateral Bridge  

• Targeted Muscle = Gluteus medius & Gluteus maximus

• Lay on your back with your hands by your sides, your 
knees bent and feet flat on the floor. 

• Feet and knees should be approximately shoulder width 
apart.

• Tighten your abdominal and buttock muscles.

• Raise your hips up to create a straight line from your 
knees to shoulders.

2. Standing Leg Abduction

• Targeted Muscle = Tensor fasciae latae

• Hold on to a chair back to help balance.

• Keeping toes pointed forward, foot flexed, and leg 
straight, lift the foot off the ground and out to the side.

• Lower the leg without letting the foot or leg rest to 
complete one repetition.  
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3. Forward Lunge 

• Targeted Muscle = Gluteus maximus

• Stand with your feet hip-width apart, hands on hips (if you 
prefer). 

• Keep your chest lifted and back straight, take a large step 
forward (about three feet) with the foot so the knee is bent 
90 degrees and the thigh is parallel to the floor. 

• Keep your knee centered over your foot. Push off the foot 
to return to the starting position. 

4. Clam

• Targeted Muscle = Gluteus medius

• While lying on your side, keep both knees bent and flex the 
hips to about 30 degrees. 

• While keeping your heels touching and pelvis still, open 
your knees by contracting your glute medius. This is a 
slow, small and targeted movement. 

• You can place your hand on your gluteus medius (just 
below and behind your hip) to ensure that it is firing during 
the movement. 

5. Squat

• Targeted Muscle = Gluteus maximus

• Stand with your head facing forward and your chest held up 
and out. 

• Place your feet shoulder-width apart. Extend your hands and 
lightly grasp the top of a chair for balance.

• Sit back and down, like you are “sitting”.  Keep you head 
forward and let your lower back arch slightly as you “sit”.

• Allow yourself to lower until your thighs are parallel to the 
floor, knees over ankles, weight into your heels.

• Keep your core tight and push through your heels to return 
to the starting position.
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6. Side-Step

• Targeted Muscle = Gluteus medius

• Place your feet front and shoulder width apart

• Keep your feet in line with your shoulders, and face forward 
with your body weight evenly distributed over both feet. 

• Shift your weight over one leg and take a step laterally 
(sideways) with the other leg. 

• Keep your hips level during the movement. Try not to 
bounce up and down or sway side to side. 

• Slowly shift your weight to the moved leg and bring the 
other leg inward to a new ready position and repeat. 

7. Standing hip extension (to the rear) with knee extended.

• Targeted muscle = Gluteus medius

• Stand straight, facing a wall.  Have your body as close to the 
wall as possible so that you cannot bend forward while doing 
this exercise.

• Stand on one leg, for better balance hold arms to sides. Keep 
other leg straight, pointing slightly back. 

• Extend the hip to move free leg back. 

• Return and repeat. 

8. Standing hip extension (to the rear) with knee flexed

• Targeted muscle = Gluteus maximus

• Follow same directions as above in number 7.  Before moving leg to the rear, flex 
the knee at a 45 degree angle.
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9. Forward Step-Up

• Targeted Muscle = Gluteus medius; some carry-over to Gluteus maximus

• Begin by standing in front of a 4” aerobic step, facing 
forward.

• Place one foot in the middle of the step.

• Step up as you balance your body for 4 seconds.

• Step down and repeat

10.  Standing Hip Hike

• Targeted Muscle = Tensor fasciae latae

• Begin by standing in front of the 4” aerobic step.

• Place one leg straight and the other leg raised off the floor on the aerobic step.

• Rest your weight on the leg on the step, hold a chair for balance if needed.

• Hold a posterior pelvic tilt to engane the right muscles

• Using the leg on the floor, raise your hip and pelvis by hiking your hip towards the 
ceiling. As you do this you should feel a contraction on the outside of your hip and 
in your lateral trunk.

• Hold this position for the time stated in the lab, then slowly lower your hip and 
pelvis back towards the floor to be even with the leg standing on the step.

• Do not allow your shoulders to move from side to side . 
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